CHAPTER 12

Module: GRASS

GRASS (Geographic Resources Analysis Support System) is a well-known open source GIS
with a wide array of useful GIS functions. It was first released in 1984, and has seen much
improvement and additional functionality since then. QGIS allows you to make use of GRASS’
powerful GIS tools directly.

12.1 Lesson: GRASS Setup

Using GRASS in QGIS requires you to think of the interface in a slightly different way. Re-
member that you’re not working in QGIS directly, but working in GRASS via QGIS.

The goal for this lesson: To begin a GRASS project in QGIS.

3
12.1.1 ¥ Follow along: Start a New GRASS Project

To launch GRASS from within QGIS, you need to activate it as with any other plugin.
* In the Plugin Manager, enable GRASS in the list:
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& QGIS Plugin Manager

Filker

To enable | disable a plugin, click its checkbox or description

Dxfzshp Converter [« ]

s Converts From dxf ko shp file Format
Installed in ¥ector menu;/toolbar

GPS Tools
P Tools For loading and importing GPS data

Installed in ¥ector menu;toolbar

GRASS

GRASS |aver

Installed in Plugins menu,/toolbar

GdalTools (Yersion 1.2.29)

x E Integrate gdal bools inko qgis
Installed’in Raster menu,/toolbar

Georeferencer GDAL

{.J_" Georeferencing rasters using GOAL -
Installed in Raster menu,/toolbar

Flugin Directory: C: fOSGeodn fapps/qois-dev)plugins

Select Al Clear all Cancel

The GRASS toolbar will appear:

"TELI L EEIEE

Before you can use GRASS, you need to create a mapset. GRASS always works in a database
environment, which means that you need to import all the data you want to use into a GRASS
database.

* Click on the New mapset button:

¥

You’ll see a dialog explaining the structure of a GRASS mapset.
* Create a new directory called grass_db in exercise_data.

 Set it as the directory that will be used by GRASS to set up its database:
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& New Mapset

GRASS Database
Select existing direckory or create a new one:
Database: exercise_data/grass_db Browse, .
GRASS data are stored Example directory tree:
in tree directory Tree Comment
struciure. ThE GRASS El- ourDatabase Database
database is the top-level Bl Mexica Location 1
directory in this tree { i PERMAMENT Syskem mapset
structure. i i Alejandra User's mapset
i e Juan User's mapset
[=F Mew Zealand Location 2
o PERMAMNEMT Svskem mapsek
o Zimrman User's mapset
< Barck ] [ Mextk = Zancel

GRASS needs to create a “location”, which describes the maximum extents of the geographic
area you’ll be working in.

e Call the new location South_Africa:
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& New Mapset

GRASS Location

Locakion

() Select location | = ]

® Create new location | SouthAfrica

The GRASS |location is a collection of maps for a paricular territary ar project.

* We’ll be working with WGS 84, so search for and select this CRS:
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& New Mapset

Projection

Coordinate system
Mok defined

® Projection

Filter ' 4326

Recently used coordinate references systems

Conrdinate Reference Swakem autharity 10D

| W35 84 q EPSi5: 4326

1 | (4]
Coordinate reference systems of the world Hide deprecated CR5s
|C|:n:ur|:|inate Feference System Autharity I0
=- '@' Gecgraphic Coordinate Systems
e WS B EPSiG:4 326

(<] ERan

+proj=longlat +datum=W3584 +no_defs

% Back Cancel

* Now select the region South Africa, which is already defined in GRASS:
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& New Mapset

Default GRASS Region

i -21.27
W 13.65 E 33.95
5 -35.9
Set current QEIS extent | South Africa B Set

The GRASS region defines aworkspace for raster modules. The default region is valid
for one location. tis possible to set a different region in each mapset. ltis possible to
change the default location regian later,

; < Back |! Mext = | | Cancel

* Create a mapset, which is the map file that you’ll be working with.
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& New Mapset

Mapset

Mew mapset: |grass_mapset|

The GRASS mapsetis a collection of maps used by one user Auser can read maps
from all mapsets in the location but he can open forwriting only his mapset (owned by
user.

< Back Zancel

Once you’re done, you’ll see a dialog asking you to confirm that the settings it displays are
correct.

e Click Finish.

* Click OK on the success dialog.

12.1.2 & Follow along: Loading Vector Data into GRASS

You’ll now have a blank map. To load data into GRASS, you need to follow a two-step process.

* Load data into QGIS as usual. Use the streets.shp dataset (found under
exercise_data/) for now.

¢ As soon as it’s loaded, click on the GRASS Tools button:

%N

* Find the vector import tool by entering the term v. in.ogr.qggis in the Filter field of
the dialog that has appeared.

The v stands for “vector”, in means its a function to import data into the GRASS database,
ogr is the software library used to read vector data, and ggis means that the tool will look
for a vector from among the vectors already loaded into QGIS.

* Once you’ve found this tool, click on it to bring up the tool itself:
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& GRASS Tools: South_Africa/grass_mapset

Modules Tree | Maodules Lisk | Browuser I S f l

Module: w.in.ogr.ggis

Options | Qutput | Manual |

~Loaded lawver

[Select a layer | ‘r]

Password

I I

~Mame For oukput weckar map

[ |

Run Wiew output

Close

* Set the loaded layer to streets and its GRASS version’s name to g_streets to prevent
confusion.
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& GRASS Tools: South_Africa/grass_mapset

Modules Tree | Modules List | Browser | 7 %

Module: +.in.ogr.gais

Options | OQubput | Manual |

Loaded layer

skresks -

Password

[ )

Mame for output veckar map —

I q_streets I

R Wiew outpuk Close

Note: e Note the extra import options provided under Advanced Options. These include
the ability to add a WHERE clause for the SQL query used for importing the data.

* Click Run to begin the import.

* When it’s done, click the View output button to see the newly imported GRASS layer in
the map.

Close first the import tool itself (click the Close button to the immediate right of View
output), then close the GDAL Tools window.

* Remove the original roads_33S layer.

Now you are left with only the imported GRASS layer as displayed in your QGIS map.

12.1.3 & Follow along: Loading Raster Data into GRASS

Recall that our DEM is in the Projected CRS UTM 33S / WGS 84, but our GRASS project
is in the Geographic CRS WGS 84. So let’s reproject the DEM first.
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e Load the srtm_41_19.tif dataset (found under
exercise_data/raster/SRTM/) into the QGIS map as usual, using QGIS’
Add Raster Layer tool.

* Reproject it using GDAL Warp tool (Raster — Projections — Warp (Reproject)), setting
it up as shown:

& Warp [Reproject)

Bakch mode (for processing whole direckory)

Input File arkm_41_19.kF |+ Select. ..

Cukput File TM{DEM_\WiESS4 Select. .
®| Source SRS EPSG:3E2733 Select, ..

X Target SRS EPSG:4326 Select. ..

X Eesampling method Mear

Mo daka values [l:l

Mask laver [

Memory used For caching [EDME

Resize

width | 3000 = Height |3000

Use multithreaded warping implementation

X Load into canvas when finished

* Save the raster under the same folder as the original, but with the file name
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DEM_WGS84.tif. Once it appears in your map, remove the srtm_41_19.tif
dataset from your Layers list.

Now that it’s reprojected, you can load it into your GRASS database.
* Open the GRASS Tools dialog again.
* Click on the Modules List tab.

e Searchforr.in.gdal.qgis:

k¢ GRASS Tools: South_Africalgrass_mapset

Modules Tree | Modules List | Browser |

Filter [r.in.gu:lal.qgis ]

L ':{> Q r.in.gdal.qais. loc
iy Import loaded raster and create a fitked lacation

rin.gdal.ggis

Import lnaded rasker
N :D r.in.gdal.qais
@ Impart lnaded raster

L ':{> r.in.gdal.gais. loc
Impart lnaded raster and create a fitted lacation

Close

Which gives you this tool:
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& GRASS Tools: South_Africa/grass_mapset

Modules Tree Modules List Browser o

Module: rin.gdal. gois
Options Cubput: Manual |

Loaded layer

Select a laver -

Password

Mame for output raster map —

5

q_dem

R Wigw oukpuk Close

Close

Set it up as shown (input layer is DEM_WGS84, output is g_dem).
Click Run.

When the process is done, click View output.

Close the current tab, and then Close the whole dialog.

Lawers @
- Li:“ g_streets

8t - ?g_dem

® Control rendering order
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* You may now remove the original DEM_WGS84 layer.

12.1.4 In conclusion
The GRASS workflow for ingesting data is somewhat different from the QGIS method, because
GRASS loads its data into a spatial database structure. However, by using QGIS as a frontend,

you can make the setup of a GRASS mapset easier by using existing layers in QGIS as data
sources for GRASS.

12.1.5 What’s next?

Now that the data is imported into GRASS, we can look at the advanced analysis operations
that GRASS offers.

12.2 Lesson: GRASS Tools

In this lesson we will present a selection of tools to give you an idea of the capabilities of
GRASS.

12.2.1 ¢ Follow along: Set Raster Colors

* Open the GRASS Tools dialog.

* Look for the r.colors.table module by searching for it in the Filter field of the
Modules List tab.

* Open the tool and set it up like this:

Marne of input raster map

g_dem { g_demi@grass_mapsek ) - |

Type of color kable

Color palette For Shutkle Radar Topoagraphy Mission elevation -

When you run the tool, it will recolor your raster:
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12.2.2 0 Follow along: Visualize Data in 3D

GRASS allows you to use a DEM to visualize your data in three dimensions. The tool you’ll
use for this operates on the GRASS Region, which at the moment is set to the whole extent of
South Africa, as you set it up before.

* To redefine the extent to cover only our raster dataset, click this button:

[y

When this tool is activated, your cursor will turn into a cross whe over the QGIS map canvas.
* Using this tool, click and drag a rectangle around the edges of the GRASS raster.
* Click OK in the GRASS Region Settings dialog when done.

e Search for the nviz tool:
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t¢ GRASS Tools: South_Africa/grass_mapset

Modules Tree | Modules List | Browser |

Filker | mviz

- nwiz
30-Yiewer (NYIZ)

== =

Close

 Set it up as shown:

Mame of raster mapis) For Elevation

g_derm { g_dem@grass_mapsek ) - ]:[

Mame of raster map(s) For Colar

...............................................................................................

Marne of wector linesfareas overlay mapls)

g_streets [ g_streeks@grass_mapsek 1 line ) |~

* Remember to enable both Use region of this map buttons to the right of the two raster
selection dropdown menus. This will allow NVIZ to correctly assess the resolution of
the rasters.

¢ Click the Run button.

NVIZ will set up a 3D environment using the raster and vector selected. This may take some
time, depending on your hardware. When it’s done, you will see the map rendered in 3D in a
new window:
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NVIZ [NEE]
File  Appearance Visualize Scripting Help
oRaw | Clear | ancel |

Automatically render display: 7

Show features:  Main features.. —l|gecoranon5. —l|

View method:  eye  center { flynone —i

Look

here __ [
height | Z-exal

{3854 .4 0.000C

center
top
reset

T B ] B |
perspective {400 twist|0.0

Experiment with the height, z-exag, and View method settings to change your view of the data.
The navigation methods may take some getting used to.

12.2.3 % Follow along: The Mapcalc Tool

* Open the GRASS Tools dialog’s Modules List tab and search for calc.
* From the list of modules, select nmapcalc (not rmapcalculator, which is more basic).
* Start the tool.

The Mapcalc dialog allows you to construct a sequence of analyses to be performed on a raster,
or collection of rasters. You will use these tools to do so:

O NI R

In order, they are:
* Add map: Add araster file from your current GRASS mapset.
* Add constant value: Add a constant value to be used in functions.

* Add operator or function: Add an operator or function to be connected to in-
puts and outputs.

* Add connection: Connect elements. Using this tool, click and drag from the red
dot on one item to the red dot on another item. Dots that are correctly connected to a
connector line will turn gray. If the line or dot is red, it is not properly connected!
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e Select item: Select an item and move selected items.

* Delete selected item: Removes the selected item from the current mapcalc
sheet, but not from the mapset (if it is an existing raster).

Using these tools:

* Construct the following algorithm:

Maodule: r.mapcalc

Options | Qutput | Manual |

T e

B s inw=Ead

Cutpuk | altitude_range

* When you click Run, your output should look like this:

r.mapcalc “altitude_range = ({{g_dem@grass_mapset =500} | | {(g_dem@grass_mapset=1000)))"
Successfully finished

* Click View output to see the output displayed in your map:
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This shows all the areas where the terrain is lower than 500 meters or higher than 1000 meters.

12.2.4 In conclusion

In this lesson, we have covered only a few of the many tools GRASS offers. To explore the
capabilities of GRASS for yourself, open the GRASS Tools dialog and scroll down the Modules
List. Or for a more structured approach, look under the Modules Tree tab, which organizes
tools by type.
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